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NorthClark Computing, Inc. 

INTRODUCTION 
NorthClark’s Non-Conforming Corrective Action Notice System formalizes the process of reporting 
defects in purchased parts, notifying the supplier that corrective action is required and allows the Buyer 
to decide whether the Supplier’s performance rating should be impacted by the event.  The Non-
Conforming Corrective Action Notice procedure is a Windows based desktop application that contains 
the following major components:  

 The ability to create, view and modify the NCCAN records.  
 Provides documentation for in-house repairs of defective parts. 
 The ability to record failures and impact supplier performance rating without generating a 

debit memo. 
 Allows e-mail notification to be automatically sent to the Supplier, with the NCCAN 

attached as a Word document or PDF file. 
 Updates the NCCAN status in BWB automatically upon response from the Supplier or after 5 

working days to “Pending” and provides a Workflow Alert 

Environment
When you enter the Non-Conforming Corrective Action Notice application you will initially be taken to 
the PO Detail screen. This screen is comprised of four tabs:  

PO Detail Line item detail for the selected purchase order. 

Receipts A summary of receipts and returns for the selected line item. 

NCCAN Entry Entry of details regarding non-conforming material. 

Review Allows entry of Status and Disposition information 
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Main Screen 

PO Detail 

The PO Detail screen displays a listing of all the line item detail for a specific purchase order. 

 

You may enter a PO Number directly or search for the Purchase Order by clicking on the […] icon next 
to the PO Number field.  Clicking on this button will transfer you to the PO Search function where you 
may Locate a PO.  

Once you have entered the PO Number the line items associated with that Purchase Order will be listed. 

To work with a specific Receipt enter the PO LI# in the Line Item prompt.  This will transfer you to the 
Receipts screen. 

Receipts 

The Receipts screen displays a summary of all the receipts and returns for the selected line item. 
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The information included on this screen is: 

Qty Ordered Line Item Order Quantity 

Balance Due Balance Due from Supplier 

Qty Received Total Qty Originally Received 

Qty Accepted Qty Not Returned to Supplier 

Accepted % Qty Accepted / Qty Received 

Rejects Returned Qty Returned on a Reject Debit Memo 

Rejects Used As Is Qty Rejected but Not Returned.  Qty entered on NCCAN 
Entry screen as Qty Repaired / Used As Is 

Other Debits Non Reject Debit Memo transactions 

Receipt Number Debit Memo ID # 

Receipt Date Debit Memo Date 

Qty Quantity Returned 

Reject Code QA Reject Code Assigned to the Return 
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Supplier’s Fault? If checked then update Vendor Performance 

Error Correct? If checked, indicates that this is an error correction only. 

Credit / Replace Is it a return for credit only or for a replacement? 

After reviewing the Receipt information the Non-Conforming Corrective Action Notice may be 
generated.  To generate an NCCAN click on the New button to the right of the NCCAN# field.  This will 
transfer you to the NCCAN Entry screen. 

NCCAN Entry 

The NCCAN Entry screen allows you to enter details regarding the non-conforming material. 

 

The following information should be entered on this screen: 

Inspection Date Select the date that the inspection took place 

Inspected By Enter the name of the inspector 

Preparer’s Email Email address of the individual preparing the 
NCCAN 

Debit Memo Id If the NCCAN is related to a Debit Memo, select 
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the Debit Memo from the drop down list 

Qty Returned If a Debit Memo is entered the quantity will 
default from the Debit Memo.  This value may 
not be updated 

Qty Inspected Enter the total quantity inspected. 

Qty Repaired/Used As Is Enter the Qty Rejected but Not Returned.   

Est. In-House Repair Hours Enter the estimated time it will take to perform 
the repair. 

Details of Non-Conforming Items Enter details of the defect.  This is a free form 
entry field. 

Defect Type Select the Defect Type from the drop-down 
window (See Note 1 below).  Multiple defect 
types may be entered for a single line item. 

Notes Enter any notes regarding the defect type. 

Note I – The Defect Type code is created in the Type Code administration procedure.  The system 
administrator can assist you in setting up the defect type codes. 

Below is an example of the entry of a NCCAN for an item that was returned on a Debit Memo. 
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Below is an example of the entry of a NCCAN for an item that is being repaired in house: 

 

Once the NCCAN has been created, the Review procedure is followed to distribute and update the status 
of the NCCAN.  When initially created the status is "New, Needs Review". 

Review 

Once the NCCAN has been created, the following procedure may be followed to distribute and update 
the status of the NCCAN.  When initially created the status is "New, Needs Review". 
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Note, at any time during this procedure, the NCCAN status may be reviewed on the Review screen. 

 Print and/or email the supplier for their comment and review.  To print and/or email the NCCAN 
select Print/Email NCCAN from the File menu.  The following message will be presented when 
the selection is made: 

 

Click OK to change the status to "Open, Supplier Notified", click Cancel to leave the status as "New".  
If the status is left as "New" you must manually update the status in the Review screen to Open when the 
supplier is notified. 

The Supplier may respond by traditional means (phone, email, etc.) or they may visit the Supplier Portal 
web site to enter comments regarding the NCCAN.  After the Supplier’s comments are entered, or 5 
working days pass (whichever is sooner), the status of the NCCAN changes to “Pending, Supplier 
Responded” and a Workflow Alert appears on the Buyer’s Workbench.   
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The Buyer may then enter or update the disposition code (which determines fault) and close the 
NCCAN. 
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Main Menu Options 

Following is a brief description of the options available from the Main Menu of the Non-Conforming 
Corrective Action Notices application. 

Menu Option Description 

File Clear Display Clear all current data on all displays. 

 Save NCCAN Save your changes to the database. 

 Print/Email NCCAN Print or email the NCCAN to the supplier.  See Print or Email the 
NCCAN to a Supplier. 

 Print Print the current active spreadsheet.   

 Export Export data from the active spreadsheet.   

 Exit Close the application 

Edit Copy Copy data to the Windows clipboard.   

 Cut Cut data from the field and copy it to the Windows clipboard.   
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 Paste Paste data from the Windows clipboard.   

 Fill Update all of the selected cells from the Windows clipboard.   

 Zoom View, print and/or edit the expanded contents of a field.   

 Insert Row Insert a Row immediately above the current row you are in. 

 Delete Row Delete the Row that you are currently in. 

View Auto Fit Columns Automatically adjust the width of each column to accommodate 
your data.  

 Unhide All Columns Expose all columns previously hidden. 

 Display Options Set user preferences affecting the appearance of the screen. 

Tools NCCAN Search See NCCAN Search 

 Part History See Part History 

 Part Number Search See Part Number Search 

 PO Search See PO Search 

 Supplier Search See Supplier Search 

Right Click Menu 

Copy Copy data to the Windows clipboard. 

Cut Cut data from the field and copy it to the Windows clipboard 

Paste Paste data from the Windows clipboard 

Fill Update all of the selected cells from the Windows clipboard. 

Zoom View, print and/or edit the expanded contents of a field. 

Select All Select all the data on the screen. 

Insert Row Insert a Row immediately above the current row you are in. 

Delete Row Delete the Row that you are currently in 
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File Menu 

Print or Email the NCCAN to a Supplier 

The NCCAN system provides the option of generating the NCCAN and either printing the 
document or emailing it directly to the supplier.  To prepare the document for print and/or email 
to the supplier select Print/Email NCCAN from the File menu or the Print/Email icon located on 
the toolbar.  When selected, the following screen will be presented: 

 

 Enter the path where the NCCAN Word Template is stored 

 Enter the Name of the NCCAN Word Template 

 Enter the path where NCCAN documents will be stored 

 The system will assign the NCCAN Document Name 

 Select the action to be taken when the Word document is created 

o Display the Document (the document can be later emailed or printed) 

o Print the Document 

o Email the document 
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o Create PDF 

 Select the Transmission Method from the drop-down list 

o Email 

o Fax 

o Mail 

o Web 

 Click on the Create Word Doc to create the NCCAN Word document 

o The NCCAN will be created. 

o If Print the Document was selected, a printed copy will be created. 

o If Email the document was selected the email will automatically be created and sent 
to the supplier. 

If Display Word document was selected and you wish to email with additional comments, select the e-
mail screen to add additional comments. 
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Tools Menu 

NCCAN Search 

Selecting NCCAN Search from the Tools Menu accesses the following screen.  This screen can be used 
to enter the search criteria necessary to locate the NCCAN. 

 

Several fields are provided to assist you in narrowing your search.  You may fill in as many or as few of 
the fields as you wish.  The more data you provide the narrower the search.  If all fields are left blank, 
the system will return all purchase orders based on the status you have selected. 

The fields that have been provided for your search includes:  Supplier(s), Warehouse, Work Order 
Number, Part Number and Buyer. 

In addition to the fields mentioned above, a section has been provided to select the status of the order 
that can be used to narrow the search.  The status selections that can be utilized are New, Open, Pending, 
Final and Canceled.  Check as many or few as needed to locate the NCCAN. 

NCCANs may also be searched within a specific transaction date range. Make the desired selections by 
clicking the appropriate checkbox and enter the date(s) that you want to use in your search. 
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If you do not know the specific details of the field, you can use wildcarding to enter only a portion of the 
name or number. 

Once the search criteria have been entered, click the Find button and the system will begin to process 
the search.  If no records are found the following message will be displayed: 

 

If records are found, the following page will be displayed while the system completes the selection 
process: 

 

To cancel this process, click the Cancel button. 

When the search is complete, you will be presented with a list of NCCANs that can be selected for 
review. 
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To select a NCCAN you can either highlight the row and double click or click on the Open button.  You 
will be transferred to the NCCAN Entry screen and the NCCAN information will be loaded. 

Column Field Descriptions 

PO # The identification number for the PO. 

PO Line # Line Item Number on the Purchase Order 

NCCAN # NCCAN Number 

NCCAN Date Date NCCAN was created. 

Status Current status of the NCCAN 

Supplier ID Number or Code assigned to a specific Supplier (Vendor ID). 

Supplier Name Name of the Supplier/Vendor. 

Whse The Ship To Warehouse(s) for the line items on this Purchase Order. 

Buyer The buyer ID assigned to this purchase order. 

Work Order Work Order Number associated with the PO line item. 
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Part Number Part Number ID Number 

Part Description Part Number Description 

Inspect Qty Number of items inspected. 

Returned Qty Number of items returned on a debit memo. 

Use As-Is Qty Number of items designated to use as-is. 

Inspected By Name of who inspected the items. 

Part History 

Selecting Part History from the Tools Menu accesses the following screen.  It displays a list of recent 
purchase orders and receipts for a selected part number. 

 

 

 Enter the Part Number or use the pull-down menu to select a part number.  Part Numbers currently 
included on the PO or Receipt will be included in the list, or you may type any valid Part Number. 

 You may enter a date range by clicking the appropriate checkbox(s) and entering the desired date(s).  
The ‘To Date’ defaults to today’s date when searching.  Note:  the search is performed on the date 
the PO/Quote was filed. 
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 Click the Search Button when you are ready to search.  A message will be displayed indicating that 
the search is being performed. 

Column Definitions 

Type The source of the transaction 

PO = Receipt against a Purchase Order 

Quote = A quotation entered on a Request for Quote (RFQ) 

PO/RFQ Date The creation date for the PO or RFQ 

DOC# The identification number for the PO or RFQ 

LI# The line item ID # assigned to the Receipt or RFQ item being 
reported 

Supplier Number Number or Code assigned to a specific Supplier. (Vendor ID) 

Supplier Name Name of the Supplier/Vendor 

Order/RFQ Qty The total quantity ordered is the sum of all scheduled delivery 
quantities for the line item. 

Qty Received The total quantity received is the sum of all the receipt quantities for 
the line item. 

Unit Price The unit price entered on the PO or Quote.  The unit price does not 
reflect any changes to price that may have occurred during Accounts 
Payable processing 

Resource The resource code assigned to this PO or RFQ line item.   

Work Order# The work order number that the Receipt or RFQ line item is being 
assigned to. 

Line Notes Notes entered against this specific PO or RFQ line item.  This field 
will contain the word “NOTE” if there is a line item note.  Click on 
this field and the note will be displayed. 

Change Notes Change notes entered against this specific PO line item.  This field 
will contain the word “NOTE” if there is a line item note.  Click on 
this field and the note will be displayed. 

Cost Group Cost Group used for Part Cost History Information 

Hist. Average Historical Average for the Cost Group 
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Last Cost Last Cost for the Cost Group 

Part Number Search 
The Part Number Search Query helps you locate a Manfact Part Number using a variety of search 
criteria.  Please see Part Search Query User Guide for more information. 

Note:  The NCC Part Number Search Query is sold separately.  If this option is not currently available, 
please contact your System Administrator or NorthClark Computing, Inc. to obtain a copy of 
NCC_PARTSQ. 

PO Search 

Selecting PO Search from the Tools Menu accesses the following screen.  It displays a list of recent 
purchase orders a selected supplier. 

 

Enter your selection criteria, and then click the Find button.  You may use as many fields as desired to 
narrow your search, and wildcarding is supported for text fields. 
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When the search is complete, you will be presented with a list of purchase orders that can be selected for 
review.  Double-click on a row to open a Purchase Order, or if you prefer, highlight the row and click 
the Open button. 

Note that when the search window is closed and reopened, the results of your last search are redisplayed.  
This is a useful feature for selecting and updating groups of records without having to search again and 
again.  However, the information on this display is refreshed only when the search is performed, so care 
should be taken as the data could become stale. 

Column Field Descriptions 

Date The creation date for the PO. 

PO # The identification number for the PO. 

Supplier ID Number or Code assigned to a specific Supplier (Vendor ID). 

Supplier Name Name of the Supplier/Vendor 

Whse The Ship To Warehouse(s) for the line items on this Purchase Order. 

Status The current status of the Purchase Order: 

 New: There have been no receipts against the purchase order. 

 Backordered:  There has been a receipt against the purchase order and 
there is a quantity remaining to be received 

 Closed:  All line items have been fully received 

 Closed and Paid:  All Line items have been fully received and paid for. 

Buyer The buyer ID assigned to this purchase order. 

Next Due Date The earliest due date of an open or backordered line item with remaining 
quantity to be received. 

On Hold If a checkmark is found in this column, there is a “hold” code assigned to either 
the purchase order header or an open or backordered line item. 

Late If a checkmark is found in this column there is an open or backordered line item 
that is past due to the scheduled delivery date. 

PO Value The total value of the Purchase Order. 

Supplier Search 
Selecting Supplier Search from the Tools Menu accesses the following screen.  It displays a list of 
various supplier information. 
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Note, a performance rating of –100 indicates there is no data available for the Supplier. 

Column Description 

Code Supplier ID Number that has been assigned to this record. 

Name Supplier Name 

Q Quality Percentage.  Note, a rating of –100 indicates there is no data available for this 
supplier 

D Delivery Performance Percentage 

Q & D The combined Quality & Delivery Performance Percentage 

Level Supplier Portal Security Level 

Phone The contact Phone Number. 

Contact A contact name. 

Address A right click will present the full address for this supplier 

Notes A right click will present all notes recorded for this supplier. 
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General Information 

Printing a Spreadsheet 

Below is a sample of the screen that will appear when you select the Print option.  This will print the 
current active spreadsheet, so be sure to click on the spreadsheet you wish to print before choosing the 
Print option. 

 

Range - Selecting a Print Range  

You may choose to print the entire spreadsheet (all), selected cells (those that you have highlighted 
on the current screen), the current page (only the rows that are currently visible on your screen), or a 
range of page numbers.  

Orientation - Portrait or Landscape  

You may print your report in portrait mode (normal) or landscape mode (sideways). Printing in 
landscape mode will allow you to fit more columns of information on your report.  
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Margins - Report Margins  

You can make your report more attractive by setting the top, bottom, left, and right margins. Reduce 
the left and right margins if you need to fit more columns on the report.  

Units - Inches or Centimeters?  

Are the margins you entered expressed in inches or centimeters?  

Page Order  

If your report is too wide, it may span multiple pages. When this occurs, do you want the report 
printed from top to bottom or left to right?  

What Do You Want to Print?  

You can customize the appearance of your report by printing (or not printing) column headers, row 
headers, grid lines, borders, shadow, and color.  

Headers and Footers  

Your report may have up to three lines for the heading, and one line for the footer. The system 
initially displays a default heading, which you may modify if desired.  

Tip: Use /p to designate a page number.  

Which Columns Do You Want to Print?  

The columns that are available for printing are listed. Select the columns you wish to include on your 
report.  

Exporting a Spreadsheet to Excel 

Below is a sample of the screen that will appear when you select the Export to Excel option.  This will 
export the current active spreadsheet, so be sure to click on the spreadsheet you wish to print before 
choosing the Export option. 
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Save As File Name 

Enter the pathname of the file you wish to create.  You may Browse the files by clicking the button to 
locate the drive and folder where the file will be stored. 

Sheet Name 

Enter the Excel sheet name to create. This will automatically default to Sheet1. 

Export to Excel or to a File? 

You may export the contents of the display directly to Excel, or you may choose to create a file in 
Excel format. 

Create a Log File? 

Select this option to create a log file. The log file contains error messages and other information 
about how your Excel file was created. The name of the log file is "CreateExcelFile.log", and it will 
be stored in the same folder as your spreadsheet. 

Export Button 

After all required information has been entered, click this button to export your data to Microsoft 
Excel. 

Editing Features 

Copy, Cut, Paste and Fill 

You may use the standard Windows Copy, Cut, and Paste features to copy data to the Windows 
clipboard, or to paste data from the clipboard into a cell.  
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To copy data, hold down the left mouse button and highlight one or more cells, then choose Copy. 
There are multiple ways to enter this command:  

1.  From the Edit menu choose Copy. 

2.  Click the Right Mouse button, and then choose Copy from the pop-up menu.  

3.  Click the corresponding icon on the toolbar.  

4.  Hold down the Ctrl key and type the letter C (Ctrl-C). 

You can use the Cut command (Ctrl-X) and the Paste command (Ctrl-V) in similar fashion.  

To copy the contents of an entire row, click once on the row header (the number displayed on the left 
side of the first cell), and then choose Copy. Now click on the row header that you want to copy the data 
to and choose Paste. 

If you want to update several cells with the same value, highlight all of the cells you wish to update then 
choose Fill Cells. This command will update each cell with the current information from the clipboard. 

 Zoom 

This feature allows you to view, print and/or edit the expanded contents of a field.  It is especially useful 
for multi-line information such as notes and long descriptions. 

• You may "Zoom in" on any selected item by selecting Zoom from the Edit Menu, clicking the 
magnifying glass on the toolbar, or selecting Zoom from the right click menu.   

• The Column Name will appear in the Title Bar with "Edit" or "View".  You may edit the field 
when it is allowed.   Click "OK" when finished, or "Cancel" to revert to the original data.  

• To print the selected item, click on the printer icon and the information will be sent to your local 
printer. 

Locked fields may be viewed but not modified using the Zoom Feature.  If the field is locked, "View" 
will appear in the Title Bar, and there will only be a single command button labeled "Done". 

Customizing Your Display / Arranging Columns 

Use the Customize Display Screen to make the following changes:  

 Each tab contains a list of fields that corresponds to a screen used in this application.  Use the 
checkboxes to show or hide each field.  

 Use the [Move Up] and [Move Down] Buttons to re-arrange the order in which the fields appear 
on the specific screen Display. Click [Reset All] to return to the system’s default settings. 
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 Select the color to use for highlighting Rows that have been modified, during data entry, but not 
saved. When you click the [Select Color…] button, a dialog is displayed allowing you to select a 
color palette. 

 You may opt for the system to “Remember Screen Size and Column Widths”. Any changes you 
make to the screen's appearance will be saved and applied the next time you launch this 
application.  

 Choose the number of columns (from left to right) you wish to freeze on the spreadsheet. A 
frozen column will remain in place as you scroll to the right.  

 Click [OK] to apply any changes you have made or "Cancel" to revert to the previous settings. 

 

Note, these settings are stored in the Windows Registry for each user. 

Wildcarding 

Wildcarding is a powerful feature that allows you to search using a portion of the field. You tell the 
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or 
end of your search entry. Here are some examples of wildcard commands and their expected results: 

Part Number:  XTR… (or Returns part numbers that begin with “XTR”  
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XTR*)  

Description: …VALVE… 
(or *VALVE*) 

Returns parts with the word “VALVE” 
anywhere in the description.  

Category: …A (or *A)  Returns parts with a category ending with the 
letter “A”.  
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